


Photoshop Decoded
Manual de Prácticas

Eric Skoglund



Indice

Introducción..............................................................................................................................................................4

Práctica 1: Introducción al Photoshop...............................................................................................5

Práctica 2: Principios Báasicos...................................................................................................................6

Práctica 3: Niveles y Curvas........................................................................................................................8

Práctica 4: Tono, Brillo y Saturación......................................................................................................9

Práctica 5: Correcciones Selectivas....................................................................................................12

Práctica 6: Capas, Mezclas y Opacidad.............................................................................................14

Práctica 7: Opacidad y Relleno................................................................................................................16

Práctica 8: Color en Dibujos.....................................................................................................................17

Práctica 9: Trazo con Plumilla....................................................................................................................19

Práctica 10: Máscaras de Vector...............................................................................................................21

Práctica 11: Selecciones y Máscaras.....................................................................................................23

Práctica 12: Aplicación de Filtros............................................................................................................26

Práctica 13: Smart Filters...............................................................................................................................28

Práctica 14: Formas Vectoriales................................................................................................................29

Práctica 15: Ilustración......................................................................................................................................31

Práctica 16: Clone Stamp...............................................................................................................................33

Práctica 17: Red Eye............................................................................................................................................35

Práctica 18: Content-Aware........................................................................................................................36

Práctica 19: Puppet Warp...............................................................................................................................37

Práctica 20: Fotomontaje................................................................................................................................39

Práctica 21: Formas Personalizadas y Texto...................................................................................41

Práctica 22: Rasterización y Transformación.................................................................................44

Práctica 23: Efectos...............................................................................................................................................48

Práctica 24: Estilos de Capa y Estilos...................................................................................................50

Práctica 25: Estilos Web....................................................................................................................................53

Práctica 26: Soportes 3D.................................................................................................................................55



Photoshop Decoded  •  Eric Skoglund
4

Introducción

A lo largo de más de 17 años de labor docente ininterrumpida, así como de mi propia 
experiencia como estudiante, me percaté de que en muchos casos los contenidos 
curriculares de las asignaturas relacionadas con la enseñanza de programas de diseño, 
carecían de una estructura y una utilidad práctica concreta, limitándose en la mayoría de 
los casos, a listar simplemente las herramientas principales y algunos aspectos cuando 
más superficiales del software, en el mejor de los casos.

Con esta idea muy clara, decidí crear este breve, empero sustancioso curso sobre uno de 
los programas que representan sin lugar a dudas, una piedra angular en la labor diaria del 
profesional de las áreas relacionadas con la imagen, el diseño y la publicidad.

Espero sinceramente que esta obra le sea de utilidad, muy apreciable lector, y que en-
cuentre en cada práctica una herramienta de aplicación que más adelante pueda usu-
fructuar para su labor de producción gráfica.

Sin más que añadir, comencemos juntos a decodificar esta gran herramienta digital.

Eric Skoglund
Autor
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Práctica 1
Introducción al Photoshop

Duración: 60 minutos

Objetivo: El practicante se familiarizará con la interfaz del programa.

Temas a practicar: Creación y guardado de archivos, comandos y resolución.

Desarrollo:
1. Creación de documentos en distintas dimensiones y resoluciones.
2. Guardado de archivos en formatos: PSD, TIFF, EPS, PDF, JPEG y Save for Web.
3. Guardado del mismo archivo en diferentes versiones.
4. Elaboración de lista de comandos, la cual el practicante deberá memorizar y aplicar.
5. Empleo de la historia en el proceso de elaboración de un documento.
6. Cambio de resoluciones con equivalencias.

Deberá obtener los siguientes resultados:
• Archivo guardado en formatos: PSD, TIFF, EPS, PDF, JPEG y Save for Web.
• Documento en Word con lista de comandos.
• Archivo guardado en resoluciones equivalentes.
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Práctica 2
Ajustes de Color: Principios Básicos

Duración: 20 minutos

Objetivo: El practicante conocerá los pormenores del manejo y corrección de color en 
el programa.

Temas a practicar: Corrección de imágenes con herramientas de ajuste de color.

Desarrollo:
1. Cambio de modos de color al documento: RGB, CMYK y Grayscale.
2. Creación de colores nuevos.
3. Importación de librerías de colores Pantone.
4. Creación y modificación de degradados.
5. Cambio de modo de color de la Práctica 2 de RGB a Grayscale.
6. Utilización de la herramienta Black & White en Image > Adjustments para calibrar 
cada gama en la escala de grises.
7. Cambio de la resolución a 75 ppi al doble del tamaño real.
8. Guardado del archivo en formato EPS.
9. Cambio de modo de color a Duotone con negro compuesto y pantone 347C.
10. Calibración con curvas en la herramienta del Duotone.
11. Guardado del archivo en formato EPS.

El practicante deberá obtener los siguientes resultados:
* Muestras en la siguiente página.
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Práctica 3
Ajustes de Color: Niveles y Curvas

Duración: 15 minutos

Objetivo: El practicante conocerá los pormenores del manejo y corrección de color en 
el programa.

Temas a practicar: Corrección de imágenes con herramientas de ajuste de color.

Desarrollo:
1. Calibración de la imagen en la pantalla utilizando las herramientas de Levels y Curves.
2. Cambio de la resolución a 200 ppi a la mitad del tamaño real.
3. Guardado del archivo en formato TIFF.

El practicante deberá obtener los siguientes resultados:
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Práctica 4
Ajustes de Color: Tono, Brillo y Saturación

Duración: 15 minutos

Objetivo: El practicante conocerá los pormenores del manejo y corrección de color en 
el programa.

Temas a practicar: Corrección de imágenes con herramientas de ajuste de color.

Desarrollo:
1. Modificación de color de la imagen Práctica 4a por medio de las herramientas de 
Brightness/Contrast, Hue/Saturation, Channel Mixer y Shadow/Highlight.
2. Modificación de color de la imagen Práctica 4a por medio de las herramientas de 
Brightness/Contrast, y teñido por medio del Hue/Saturation con la opción Colorize.
3. Modificación de color de la imagen Práctica 4b por medio de las herramientas de 
Brightness/Contrast y Selective Color.
4. Cambio de la resolución de los tres archivos a 100 ppi al doble del tamaño real.
5. Guardado de los archivos en formato JPEG, calidad media.

El practicante deberá obtener los siguientes resultados:
* Muestras en las siguientes 2 páginas.
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Práctica 5
Ajustes de Color: Correcciones Selectivas

Duración: 15 minutos

Objetivo: El practicante conocerá los pormenores del manejo y corrección de color en 
el programa.

Temas a practicar: Corrección de imágenes con herramientas de ajuste de color.

Desarrollo:
1. Modificación de color en zonas específicas de las imágenes Práctica 5a y 5b por medio 
de la herramienta de Replace Color.
2. Cambio de la resolución a 300 ppi a la mitad de su tamaño real.
3. Guardado de los archivos en formato PDF (Press Quality).

El practicante deberá obtener los siguientes resultados:
* Muestras en la siguiente página.
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Práctica 6
Capas, Mezclas y Opacidad

Duración: 75 minutos

Objetivo: El practicante empleará los diferentes aspectos que intervienen en el manejo 
de capas para la edición de documentos.

Temas a practicar: Capas, Administración de Capas, Mezclas y Opacidad.

Desarrollo:
1. Eliminar la capa “Extra” del archivo.
2. Crear una nueva capa con el nombre “Degradado supra” y aplicar un degradado del 
pantone 293 C a transparente en forma vertical desde el tope del documento hacia abajo 
hasta la mitad del mismo. Aplicarle el modo de fusión de capa Multiply al 80%.
3. Crear una capa con el texto: “El paraíso…” en la fuente Edwardian Script a 95 pts, y 
colocarlo en la esquina superior izquierda. 
4. En la paleta de tipos, crear un color RGB con los siguientes valores R:0, G:121, 
B:120, y asignarlo al texto creado.
5. Aplicar el modo de fusión de capa Screen a la capa de texto y ajustar la opacidad al 90%.
6. Crear un grupo de capas con el nombre: “Animales marinos”, e integrar en él todas 
las capas encadenadas. 
7. Dentro de este grupo de capas, desencadenar permanentemente las capas “Delfín 3” 
y “Pez 2”.
8. Volver visible la capa “Ojo”. Aplicarle el modo de fusión de capa Screen y modificar 
la opacidad al 70%. Ubicar el ojo en el cielo de la ilustración como se puede ver en la 
imagen muestra.
9. Crear una nueva capa con el nombre “Degradado infra” y aplicar un degradado del 
pantone 323 C a transparente en forma vertical desde la base del documento hacia arriba 
hasta la mitad del mismo. Aplicarle el modo de fusión de capa Multiply al 80%.
10. Crear una capa con el texto: “…sí existe.” en la fuente Edwardian Script a 95 pts, 
rellenarlo del pantone 319 C, y colocarlo en la esquina inferior derecha.
11. Aplicar el modo de fusión de capa Screen a la capa de texto y modificar la opacidad 
al 80%.
12. Volver visible la capa “Logo”. Aplicar el modo de fusión Linear Dodge, duplicarla y 
nombrarla como “Logo 2”. Modificar su opacidad al 50%.
13. Transformar el fondo en una capa dando doble click a la misma.
14. Crear una capa nueva, rellenarla con el color R: 160, G: 218, B:232, y reposicionarla 
debajo del “fondo” y nombrarla como “Base”.
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15. Aplicar el modo de fusión Luminosity a la capa de fondo.
16. Guardado del archivo en formatos PSD en capas y Save for Web a 100 kb.

El practicante deberá obtener los siguientes resultados:
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Práctica 7
Opacidad y Relleno

Duración: 10 minutos

Objetivo: El practicante identificará las diferencias entre manipular los porcentajes de 
opacidad o relleno en una capa de formas.

Temas a practicar: Manipular los porcentajes de opacidad y relleno.

Desarrollo:
1. Seleccionar la capa “Estrella”.
2. Variar el porcentaje de opacidad en la ventana de capas y observar el resultado. Re-
gresarlo al 100%.
3. Variar el porcentaje de relleno en la misma ventana de capas y observar el resultado. 
Regresarlo al 100%.
4. Identificar las diferencias entre lo que implica modificar la opacidad o el relleno de 
una capa con formas vectoriales.
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Práctica 8
Color en Dibujos

Duración: 50 minutos

Objetivo: El practicante manejará las herramientas de pintura y aplicación de color en 
dibujos.

Temas a practicar: Pintura y Color en Dibujos.

Desarrollo:
1. Transformar el documento a modo de color RGB.
2. Modificar las dimensiones del documento al doble de tamaño a 100 ppi, quitando la 
“palomita” al Resample Image.
3. Completar con la herramienta del lápiz y el color negro compuesto todas las líneas 
“incompletas” del dibujo directamente sobre la capa del fondo.
4. Rellenar con color y la herramienta de la cubeta cada una de las áreas del dibujo, 
separando cada elemento en una capa distinta (nunca colorear en el fondo) y teniendo 
cuidado de seleccionar los colores exactos a partir del archivo “Muestra Color”. Cada 
capa debe llevar un nombre que la identifique claramente en el estructura del documento.
5. Aplicar sombras y luces a mano alzada con la herramienta del pincel en capas sepa-
radas sobre cada pieza ya rellenada; variando los tipos de pinceles en su anchura y la 
dureza/suavidad de sus bordes.
6. Aplicar modos de fusión entre las capas para mezclar los juegos de luz/sombra creados 
con los pinceles.
7. Aplicar un degradado linear al fondo del documento, cargando la selección de esta 
área del dibujo por medio de la herramienta Magic Wand.
8. Guardado del archivo en formatos PSD en capas y Save for Web a 100 kb.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 9
Trazo con Plumilla

Duración: 75 minutos

Objetivo: El practicante utilizará las diferentes herramientas de trazo y edición con 
plumilla.

Temas a practicar: Trazo con plumilla.

Desarrollo:
1. Abrir los archivos de templete de cada logo y convertirlos a RGB.
2. Convertir el fondo en capa dando doble click sobre éste.
3. Crear una capa nueva, rellenarla de blanco y reposicionarla debajo de la capa del 
templete del logo; ajustar la opacidad de la capa del logo a un 40%.
4. Crear un trazado nuevo y asignarle nombre; comenzar a trazar con la herramienta de 
la plumilla el logo por piezas separadas y hacer trazados independientes para cada una 
de ellas.
5. Transformar en selección cada trazado, y rellenarlo del color/degradado correspondiente 
en capas distintas; tomando con el gotero muestras de los colores de los archivos de 
“Muestra color” de cada logo.
6. Guardado de los archivos en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestras en la siguiente página.
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Práctica 10
Máscaras de Vector

Duración: 40 minutos

Objetivo: El practicante utilizará las herramientas de trazo para recortar una imagen y 
superponerla en otra.

Temas a practicar: Trazado y recorte de imágenes.

Desarrollo:
1. Por medio de la herramienta de la plumilla, trazar todo el contorno del auto en la 
capa “Auto”.
2. Ajustar el trazado por medio de la flecha blanca, manipulando los nodos y los bastones 
cuando sea necesario.
3. Sin desactivar el trazado y teniendo activa la capa del auto, ir al menú de Layer y 
elegir la opción de Vector Mask; dentro de este submenú, seleccionar la opción Current 
Path.
4. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 11
Selecciones y Máscaras

Duración: 75 minutos

Objetivo: El practicante comprenderá el uso de las diferentes herramientas de selección y 
empleará las máscaras para la edición de imágenes.

Temas a practicar: Selecciones y Máscaras.

Desarrollo:
1. Transformar el documento “Práctica 11 base” a modo de color RGB.
2. Modificar sus dimensiones a 24 x 17 cm con 100 ppi.
3. Abrir el archivo “Cielo”, copiarlo y pegarlo en el documento base. Nombrar la capa 
como “Cielo”, y enviarla al fondo del documento.
4. Seleccionar el cielo original de la capa montes por medio de la herramienta Color 
Range. Ampliar la selección en 1 pixel con Select > Modify > Expand, y borrarlo.
5. Acomodar la capa Cielo en la imagen. Contrastar con Levels.
6. Abrir el archivo “Bosque”, copiarlo y pegarlo en el documento base. Nombrar la 
capa como “Bosque”, y reposicionarla encima de las demás capas del documento base.
7. Colocar la capa Bosque en la parte inferior del documento y ajustar su tamaño sólo 
en el sentido vertical, para abarcar una cuarta parte de la imagen. Ajustar su contraste 
con Levels.
8. Borrar el tope de la imagen del bosque con la herramienta de selección rectangular. 
9. Elegir la herramienta de selección libre (Lasso), modificar el Feather a 1 pixel, y 
comenzar a retirar partes de las copas de los árboles en la capa Bosque para lograr el 
efecto de irregularidad del follaje.
10. Abrir el archivo “Rostro 1”. Realizar Drag & Drop de ese archivo en el documento 
base y nombrar la capa como “Rostro 1”.
11. Colocar la capa Rºostro 1 encima de todas las demás. Ubicarla sobre el primer 
cuadrante de las piedras, de manera que todo el rostro quepa dentro del “monte”. 
12. Aplicar Quick Mask a esta capa y “pintar” con el pincel todo el rostro del artista. Al 
terminar, darle click al botón de Quick Mask. Borrar la selección y acomodar el restante 
de la imagen sobre la piedra. 
13. Aplicar el modo de fusión de capa Hard Light. Reducir la saturación al -75% en el 
controlador de Hue/Saturation.
14. Aplicar una máscara de capa. Colocar el negro como color de frente y seleccionar 
un pincel del ancho adecuado a la imagen; reducir la opacidad del pincel al 15% y em-
pezar a “bloquear” algunas áreas del rostro para dejar ver la piedra del fondo.
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15. Reducir la opacidad de esta capa al 90% y aplicar el mismo procedimiento con las 
imágenes Rostro 2, 3 y 4 ubicándolas sobre la piedra junto a la de Rostro 1.
16. Abrir la imagen “Letrero”, realizar Drag & Drop de ese archivo en el documento 
base y nombrar la capa como “Letrero”.
17. Cargar la selección de la capa, abrir una nueva y ampliar la selección en 5 pixeles 
por medio de Select > Modify > Expand; rellenar con color blanco con Fill.
18. Aplicar el filtro Gaussian Blur en 8 pixeles. Cambiar el modo de fusión de capa a 
Hard Light al 80% y nombrarla como “Letrero destello”.
19. Cargar la selección de la capa Letrero, y aplicarle un contorno con el pantone 2746 
C de 1 pixel de radio desde el centro.
20. Abrir la imagen “Estrella”, hacer Drag & Drop de ese archivo en el documento base 
y nombrar la capa como “Estrella 1”. Contrastar la imagen con la herramienta Levels.
21. Colocar la capa Estrella 1 en el flanco superior izquierdo al lado del letrero y encima 
de todas las capas del documento. Seleccionar el contorno de la estrella con la herra-
mienta de lazo poligonal, y aplicar una máscara de capa. 
22. Cargar la selección de la máscara, crear una capa debajo, expandir la selección por 
5 pixeles por medio de Select > Modify > Expand. Rellenarla de blanco y soltar la selec-
ción; aplicar el filtro Gaussian Blur a 8 pixeles y nombrar la capa como “Destello estrella”.
26. Duplicar estas dos capas, reflejarlas en horizontal y ubicarlas en el flanco derecho 
del letrero.
27. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 12
Aplicación de Filtros

Duración: 75 minutos

Objetivo: El practicante aplicará los diferentes filtros a una imagen modelo.

Temas a practicar: Filtros / Galería de Filtros.

Desarrollo:
1. Abrir el documento Práctica 12.
2. A través del menú galería de filtros, aplicar a cada imagen del documento, uno de los 
filtros listados; experimentando con las variables de aplicación de cada uno.
3. Una vez aplicado cada filtro, colocar el nombre del mismo a pie de cada imagen con 
la herramienta de tipografía.
4. Al completar la primera hoja, salvar el documento como Práctica 12a, abrir de nuevo 
el documento original Práctica 12 y continuar con los siguientes filtros. Guardar tantos 
documentos como sean necesarios para completar toda la lista de la galería.
5. Guardado de los archivos en formato JPEG a 12 de compresión.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página de una sola planilla de aplicación (El practicante deberá 
hacer tantos documentos de planillas se requieran para aplicar todos los filtros del 
menú).
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Práctica 13
Smart Filters

Duración: 20 minutos

Objetivo: El practicante aplicará diversos filtros a una imagen previamente selecciona-
da con la modadlidad de Smart Filters/Smart Object., y luego editará nuavamente los 
filtros ya aplicados.

Temas a practicar: Smart Filters.

Desarrollo:
1. Abrir el documento Práctica 13.
2. Seleccionar la opción de Convert to Smart Filters en el menú de Filtros.
3. Aceptar que la capa sea convertida en un Smart Object.
4. Aplicar distintos filtros a la imagen. Con cada nuevo filtro que se aplique, éste apare-
cerá listado en la capa que convertimos en Smart Object.
5. Una vez aplicados cuando menos tres filtros, editar los valores de aplicación que se 
le asignó a cada uno, dando doble click sobre el nombre del filtro listado bajo la capa 
correspondiente en la ventana de Layers.
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Práctica 14
Formas Vectoriales

Duración: 35 minutos

Objetivo: El practicante aprenderá el uso y aplicación del trazo de formas vectoriales 
en el programa.

Temas a practicar: Trazado y edición de formas vectoriales.

Desarrollo:
1. Abrir el documento “Templete vector”.
2. Cambiar el modo de color del documento a RGB.
3. Utilizar la plumilla y las demás herramientas de trazo/edición vectorial para realizar 
a manera de rompecabezas, cada una de las formas de la ilustración de templete. Cada 
pieza deberá ser realizada en una capa distinta identificada claramente con un nombre.
4. Abrir el archivo “Muestra color” en otra ventana, y con el gotero tomar todas las 
muestras de tonos correspondientes para colorear cada pieza del trazado.
5. Aplicar degradados a la lengua y la barba por medio de Layer Style/Gradient Overlay.
6. Aplicar un degradado al cabello en una capa distinta cargando su selección, y apli-
cando al final una máscara para ocultar el mismo a la altura del copete.
7. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 15
Ilustración

Duración: 120 minutos

Objetivo: El practicante empleará las herramientas de dibujo para realizar esbozos y 
trazos a mano alzada.

Temas a practicar: Ilustración a mano alzada.

Desarrollo:
1. Abrir el documento “Templete dibujo”.
2. Convertir el fondo en capa, nombrarla como “Templete” y reducir la opacidad al 70%.
3. Crear una capa nueva debajo del templete y rellenarla de blanco.
4. Crear una capa sobre el templete y utilizando la herramienta del lápiz primero, realizar 
los trazos y esbozos básicos para crear un dibujo; experimentar con el uso de distintos 
anchos y formas de lápices.
5. Crear una capa nueva bajo la del lápiz, y utilizando la herramienta del pincel con un 
ancho aproximado de 11 px y opacidad de 20%, crear sombras y efectos de profundidad 
en el dibujo.
6. Crear una capa nueva bajo la del primer pincel, y utilizar nuevamente esta herra-
mienta, pero ahora con un ancho aproximado de 20 px y opacidad de 12% para crear 
sombras de mayor amplitud en el dibujo.
7. Utilizar la herramienta de Smudge para barrer los trazos iniciales del lápiz, con el fin 
de integrarlos a la composición final de la ilustración.
8. Guardar una versión en capas como PSD.
9. Acoplar la imagen y convertirla a RGB.
10. En el menú superior de Image seleccionar Adjustments > Photo Filter/Sepia y experimentar 
con la intensidad hasta lograr el tono deseado.
11. Ajustar los niveles del documento para lograr un buen contraste de luces y sombras.
12. Guardado del archivo en formato TIFF.

El practicante deberá obtener los siguientes resultados:
* Muestras de dos resultados finales en la siguiente página.
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Práctica 16
Retoque: Clone Stamp

Duración: 90 minutos

Objetivo: El practicante empleará las diferentes herramientas de retoque del programa 
para la edición de fotos e imágenes.

Temas a practicar: Retoque.

Desarrollo:
1. Abrir el documento Retoque 1.
2. Convertir la imagen a escala de grises y ajustar los niveles del documento para lograr 
un buen contraste de luces y sombras.
3. Utilizar la herramienta de Clone Stamp para corregir las imperfecciones del documento.
4. Utilizar la herramienta de Heling Tool para restaurar los daños en la imagen.
5. Utilizar las herramientas de Sharp y Blur para enfocar y desenfocar áreas específicas 
de la imagen.
6. Utilizar las herramientas de Dodge, Burn y Sponge para balancear la exposición de 
zonas específicas del documento.
7. Utilizar las herramientas del pincel y el lápiz para reforzar sombras y efectos de pro-
fundidad en el documento.
8. Repetir los pasos para trabajar el documento Retoque 2.
9. Guardado de los archivos en formatos PSD en capas y TIFF.

El practicante deberá obtener los siguientes resultados:
* Muestras en la siguiente página.
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Práctica 17
Retoque: Red Eye

Duración: 10 minutos

Objetivo: El practicante empleará la herramienta de Red Eye para eliminar los “ojos 
rojos” del retrato.

Temas a practicar: Red Eye.

Desarrollo:
1. Abrir el documento Práctica 17.
2. Seleccionar la herramienta de Red Eye.
3. Dar click en el centro de cada ojo donde se torna rojo por causa del flash.
4. Guardado del archivo en formato TIFF.

El practicante deberá obtener los siguientes resultados:
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Práctica 18
Retoque: Content-Aware

Duración: 10 minutos

Objetivo: El practicante empleará la la opción de Fill Content-Aware para eliminar ele-
menos de una imagen.

Temas a practicar: Content Aware.

Desarrollo:
1. Abrir el documento Práctica 18.
2. Elegir la herramienta de Lasso y seleccionar la gaviota que vuela frente al arbusto, 
dando un margen alrededor de ella.
3. Seleccionar la opción de Fill en el menú de Edit. 
4. En la ventana flotante, dentro del menú contextual de Contents, seleccionar la opción 
de Content-Aware. 
5. Guardado del archivo en formato TIFF.

El practicante deberá obtener los siguientes resultados:
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Práctica 19
Puppet Warp

Duración: 40 minutos

Objetivo: El practicante utilizará las herramientas de trazo para recortar una imagen y 
posteriormente la deformará por medio del Puppet Warp.

Temas a practicar: Trazado, recorte y deformación de imágenes.

Desarrollo:
1. Por medio de la herramienta de la plumilla, trazar el contorno de la trompa del ele-
fante, cerrando el trazado por la parte superior donde se une con la cabeza, como si 
fuéramos a recortar la trompa completa del animal.
2. Una vez terminado el trazo y una vez que lo ajustamos con la herramienta de la flecha 
blanca, ir a la ventana de Paths y activar la selección del trazado dando click en el 
ícono del trazado con la tecla Cntrl/Cmd presionada.
3. Regresar a la ventana de capas y copiar dando Cntrl/Cmd C.
4. Ir al menú de Edit y en la opción de Paste Special, seleccionar Paste in Place. Nombrar 
la capa que se crea como “Trompa”.
5. Teniendo seleccionada esa capa de la “Trompa”, ir al menú de Edit y seleccionar la 
opción de Puppet Warp; se creará una especie de red sobre toda la trompa del animal. 
A esta red se le deben colocar “puntos ancla” para poder deformar la imagen, de modo 
que debemos dar click en los puntos donde queremos fijar la imagen para luego moverla 
en otras secciones.
6. Distorsionar la forma de la trompa a discresión experimentando con las características 
de la herramienta. Como verá, en la capa inferior la trompa sigue estando en su mismo 
sitio, pues sólo hicimos una copia.
7. Una vez que termine de deformar, seleccione la herramienta de movimiento, y apa-
recerá una ventana donde deberá elegir la opción de Apply para que la transformación 
se aplique definitivamente.
8. Regresar a la capa del fondo y con la herramienta del Clone Stamp, retocar tomando 
muestras del pasto para cubrir la trompa original.
9. Acoplar la imagen.
10. Guardado del archivo en formato TIFF.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 20
Fotomontaje

Duración: 45 minutos

Objetivo: El practicante empleará las diferentes herramientas de retoque del programa 
para elaboración de un fotomontaje.

Temas a practicar: Fotomontaje.

Desarrollo:
1. Abrir el documento Paisaje.
2. Convertir el fondo en capa y nombrarla como fondo.
3. Eliminar la torre de fondo de la imagen con la herramienta de Clone Stamp.
4. Eliminar la formación de roca al frente de la imagen con la herramienta de Clone 
Stamp.
5. Abrir la imagen Angel y redimensionarla a 3 cm de ancho y 100 ppi de resolución.
6. Realizar un Drag & Drop de esta imagen al paisaje y nombrar la capa como “Angel”.
7. Abrir una máscara en la capa Angel, y realizar un recorte con la herramienta del pincel.
8. Colorear la capa Angel con la herramienta Hue/Saturation; aplicar la máscara a esta 
capa.
9. Duplicar la capa Angel nombrándola como “Reflejo ángel”, reflejarla en vertical y 
colocarla a manera de relfejo de la original sobre el agua; cambiar su opacidad al 70% 
y aplicarle el modo de fusión de capa Multiply. Aplicarle a esta capa el filtro Blur/Mo-
tion Blur a 0º y 15 pixeles.
10. Crear una nueva máscara en la capa Reflejo ángel y aplicarle un degradado linear 
de negro a transparente desde la base a la mitad de la imagen, con objeto de desvanecer 
la punta de la columna.
11. Abrir la imagen ET, realizar un Drag & Drop de esta imagen al documento principal 
y nombar la capa como “ET”.
12. Colocarla en el campo medio izquierdo de la imagen, justo arriba del horizonte.
13. Aplicarle el modo de fusión de capa Linear Light y crear una máscara.
14. Por medio de la herramienta de degradado linear y los pinceles, desvanecer el fondo 
de la capa ET para integrarla con el fondo. Reducir la opacidad de la misma al 75%.
15. Abrir la imagen Ovni, realizar un Drag & Drop de esta imagen al documento principal y 
nombrar la capa como “Ovni”.
16. Colocarla al centro del documento.
17. Seleccionar el fondo negro de esta capa por medio de la herramienta Magic Wand, 
y eliminarlo.
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18. Rotar levemente la imagen en sentido contrario a las manecillas del reloj.
19. Ajustar por medio de Selective Color los valores de la imagen hacia los cálidos, 
tratando de igualar los tonos de la imagen de fondo.
20. Duplicar la capa Ovni y nombrarla como “Ovni reflejo”.
21. Reflejarla verticalmente con las herramientas de transformación y colocarla sobre el 
agua.
22. Aplicar el modo de fusión de capa Multiply y reducir la opacidad al 80%.
23. Aplicar el filtro Blur/Motion Blur a 0º y 40 pixeles.
24. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
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Práctica 21
Formas Personalizadas y Texto

Duración: 75 minutos

Objetivo: El practicante utilizará las herramientas de creación y edición de formas 
personalizadas; asimismo empleará las herramientas de texto para la creación y modifi-
cación de elementos tipográficos en un documento. 

Temas a practicar: Formas personalizadas / Trabajo con texto / Tipos.

Desarrollo:
1. Abrir un documento nuevo de 17 x 23 cm a 100 ppi, modo de color RGB; y nom-
brarlo como P_16.
2. Abrir el archivo Drop, copiarlo y pegarlo en el documento P_16; colocarlo en la 
parte inferior del mismo. Tomar una muestra del fondo negro de esta imagen, abrir una 
nueva capa debajo de esta, y rellenarla con este color.
3. Fusionar ambas capas y nombrarla como Drop.
4. Abrir una nueva capa encima nombrándola como “Marco”; hacer una selección 
vertical en la orilla izquierda de aproximadamente 2 cm de ancho y a todo lo alto del 
documento. Rellenarla con un degradado linear del color 300 C al transparente.
5. Comenzar a hacer figuras prediseñadas de un solo tipo, y personalizarlas con distintas 
dimensiones y colores, posicionándolas sólo sobre la banda del rectángulo de Marco.
6. Fusionar las capas por cada tipo de figura, y nombrar cada capa con el tipo de figuras 
hechas, por ejemplo “Círculos”, “Cuadrados”, etc.
7. Aplicar el modo de fusión Screen a todas las capas de figuras y fundirlas con la capa 
Marco.
8. Duplicar esta capa, colocarla en la orilla contraria y fusionar ambas renombrándolas 
como Marco.
9. Crear una máscara para esta capa y degradar la intensidad desde tope hacia abajo 
hasta la mitad de la misma.
10. Escribir en mayúsculas las letras A, R, T, E en distintas tipografías; una fuente Romana, 
una de Fantasía, una Sans Serif y una Script. Calibrar con grosores y tamaños para que 
todas se vean uniformes.
11. Abrir la Imagen A y ajustar el contraste y saturación de la misma con Levels.
12. Aplicar el Drag & Drop de la imagen A hacia el documento principal y colocarla 
sobre la capa y ubicación de la letra A; ajustar sus proporciones para que la imagen 
abarque toda la letra.



Photoshop Decoded  •  Eric Skoglund
42

13. Activada la capa de la imagen A, ir al menú de Layers y aplicar la opción Create 
Clipping Mask.
14. Regresar a la capa de la imagen A y corregir la ubicación de dicha imagen dentro 
de la letra si es necesario. 
15. Seleccionar ambas capas y en el menú contextual de la ventana de Layers, seleccionar 
la opción de Link Layers para que queden unidas.
16. Repetir el proceso con las demás imágenes y letras.
17. Crear un grupo de capas con el nombre “Letras”, donde se integren todas las capas 
tanto de tipografía como de sus imágenes asociadas. Pintar el grupo de color verde.
18. Dentro del grupo de capas denominado “Letras”, seleccionar la capa de la letra A y 
aplicarle el estilo de capa Bevel and Emboss. Experimentar con las variables del estilo 
de capa y aplicarlo. Copiar este estilo de capa y pegarlo en las otras letras.
19. Escribir la leyenda: “muestra pictórica universal” en una tipografía cursiva, centrada y 
de manera que el puntaje permita que la misma se centre dentro del fondo negro. Aplicar 
el efecto de capa de Gradient Overlay en modo normal al 100%, eligiendo para ello un 
degradado de arcoiris y aplicándolo de forma horizontal en el texto.
20. Abrir una nueva capa sobre Drop, crear un degradado linear de rojo a transparente 
que abarque un tercio del documento desde el tope hacia abajo. Modificar la opacidad 
en un 70% y nombrar la capa como Rojo.
21. Fundir las capas Marco, Rojo y Drop, nombrando la nueva capa como “Fondo”.
22. Por medio de la herramienta de tipografía vertical, crear el texto “arteartearte” en la 
tipografía Century Gothic Bold de 72 puntos a -250 de tracking; sobre la franja azul con 
figuras del lado izquierdo.
23. Cargar la selección de la tipografía recién creada, hacer con ella una copia de la 
capa fondo y pegarla en una nueva capa aplicándole el modo de fusión Screen; duplicar 
la capa y nombrarlas como “Arte screen 1 y 2”.
24. Copiarlas, pegarlas y ubicarlas sobre la banda derecha.
25. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 22
Rasterización y Transformación

Duración: 40 minutos

Objetivo: El practicante rasterizará capas de texto y vector aplicándoles las diferentes 
herramientas de transformación y filtros para alcanzar los resultados del templete.

Temas a practicar: Rasterización / Transformación.

Desarrollo:
1. Abrir el documento Práctica 22a.
2. Duplicar la capa de texto A.
3. Aplicarle el comando de Rasterize Layer en el menú de Layer; nombrarla como “A1”.
4. Colocarla encima de la primera muestra y aplicar el filtro de Blur/Motion Blur.
5. Duplicar tantas capas A como muestras de templete hay en el documento, y nombrarlas 
A-número en la secuencia que corresponde.
6. Colocarlas sobre cada muestra y aplicar los filtros o transformaciones que se listan en 
los siguientes pasos.
7. En la segunda muestra realizar una selección rectangular ligeramente fuera de todo el 
perímetro de la letra y aplicar el filtro Distort/Ripple.
8. En la tercera muestra realizar una selección rectangular ligeramente fuera de todo el 
perímetro de la letra y aplicar el filtro de Distort /Shear.
9. En la cuarta muestra aplicar el filtro de Pixelate/Fragment.
10. En la quinta muestra aplicar la transformación mostrada por medio de la herramienta 
de Scale.
11. En la sexta muestra aplicar la transformación mostrada por medio de la herramienta 
de Rotate.
12. En la séptima muestra aplicar la transformación mostrada por medio de la herramienta 
de Skew.
13. En la octava muestra aplicar la transformación mostrada por medio de la herramienta 
de Distort.
14. Guardado del archivo en formato PSD en capas.

1. Abrir el documento Práctica 22b.
2. Duplicar la capa Pie.
3. Aplicarle el comando de rasterizado de capa; nombrarla como “Pie 1”.
4. Colocarla encima de la primera muestra y aplicar el filtro de Artistic/Rough Pastels.
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5. Duplicar tantas capas Pie como muestras de templete hay en el documento, y nombrarlas 
como Pie-número en la secuencia que corresponde.
6. Colocarlas sobre cada muestra y aplicar los filtros y trasformaciones que se listan en 
los pasos siguientes.
7. En la segunda muestra realizar una selección rectangular amplia y fuera de todo el 
perímetro de la forma, y aplicar el filtro de Blur/Radial Blur con un rango de 27.
8. En la tercera muestra aplicar el filtro de Stylize/Emboss.
9. En la cuarta muestra aplicar la transformación mostrada por medio de la herramienta 
de Perspective.
10. En la quinta muestra aplicar la transformación mostrada por medio de la herramienta 
de Warp.
11. En la sexta muestra aplicar la transformación mostrada por medio de la herramienta 
de Flip Horizontal.
12. Guardado del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestras de cada ejercicio (22a y 22b) en las siguientes páginas.
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Práctica 23
Efectos

Duración: 40 minutos

Objetivo: El practicante empleará efectos en una imagen.

Temas a practicar: Efectos.

Desarrollo:
1. Abrir el documento Práctica 23.
2. Retocar el fondo con la herramienta de Clone Stamp para eliminar el logo del centro 
del documento.
3. Abrir el archivo M. Aplicar Drag & Drop sobre el documento de la tela y nombrar la 
capa como Mac.
4. Pintar la tela de color rojo por medio de la herramienta Hue/Saturation con la opción 
de Colorize.
5. Ajustar el contraste por medio de la herramienta Levels.
6. Modificar el modo de color del documento a CMYK.
7. Ajustar el canal Cyan en Levels con los siguientes valores: 0/1.18/237.
8. Ocultar la capa Mac.
9. Activar la ventana de Channels y seleccionar el canal Magenta; lo duplicamos. Aplicar 
Gaussian Blur de 4.5 px a este canal.
10. Seleccionarlo, copiarlo y pegarlo en un documento nuevo en Grayscale; salvarlo 
como PSD en el mismo fólder de la práctica con el nombre de “Distorsión”.
11. Activar de nuevo el multicanal dando click en CMYK. Regresar a la ventana de capas, 
soltar la selección y activar la capa Mac a la que le aplicamos filtro Distort/Displace; le 
damos OK directamente y seleccionamos el archivo “distorisón” recién creado, y nueva-
mente damos click a OK.
12. Aplicar a la capa el modo de fusión de capa Linear Dodge al 100%.
13. Duplicar la capa y aplicarle el modo de fusión de capa Multiply al 40%.
14. Guardar del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 24
Estilos de Capa y Estilos

Duración: 75 minutos

Objetivo: El practicante aplicará los estilos de capa para la creación de imágenes; y 
utilizará las herramientas de la paleta de estilos para la edición de fotografías.

Temas a practicar: Estilos de Capas / Paleta de Estilos.

Desarrollo:
1. Abrir un nuevo documento de 15 x 15 cm, en RGB a 100 ppi.
2. Definir un área de selección rectangular de 6 x 13 cm utilizando el menú superior de 
opciones en Fixed Size. 
3. Dar un click en la pantalla para crear la selección y la centramos. Dando click a 
Refine Edges, redondeamos las orillas del rectángulo a 5 pixeles, con un constraste al 
100%.
4. Crear una nueva capa y rellenar la selección con el pantone 457 C. Nombrar la capa 
como Base. Aplicar el estilo de capa Bevel and Emboss y explorar los valores de profun-
didad, sombras y luces.
5. Cargar la selección de esta capa, crear una nueva capa encima y rellenarla con el 
pantone 140 C. Nombrar la capa como “Madera”.
6. Aplicar el filtro Add Noise al 101% con las opciones Gaussian y Monochromatic.
7. Deseleccionar el objeto y aplicar el filtro Blur/Motion Blur a 0° y 57 pixeles.
8. Aplicar el filtro Liquify y con las herramientas del Forward Wrap y Push Left, creamos 
las vetas de la madera. Cuando tengamos el efecto deseado damos OK.
9. Activar la capa Madera y aplicar el modo de fusión de capa Overlay; ajustar Levels 
para contrastar la veta.
10. Crear una capa de texto con la palabra “Pianos”, en Century Gothic Bold Italic de 30 pts.
11. Aplicar un estilo de capa de Stroke con un contorno de 3 pixeles de color blanco.
12. Aplicar un estilo de capa de Gradient Overlay de rojo a azul fuerte en sentido vertical.
13. Crear nuevas capas de texto por separado con las siguientes palabras: “Guitarras”, 
“Bajos”, “Vientos” y “Cables”; repartirlas sobre la barra de menús, centrándolas con las 
herramientas del menú de opciones.
14. Copiar el estilo de capa del texto de “Pianos” y pegarlo a cada capa de texto creada.
15. Crear una selección rectangular rebasada que simule la ranura entre menús en una 
nueva capa y rellenarla del color 462 C.
16. Copiar y pegar esta “ranura” entre cada texto sobre la capa de la madera; fundir estas 
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capas de ranuras y aplicarles el modo de fusión de capa Vivid Light; nombrar la capa 
como “Ranuras madera”.
17. Cortar con una selección rectangular el hueco entre el menú de Guitarras y Bajos 
de las capas de Base y Madera.
18. Crear una nueva capa debajo, hacer una selección más angosta a lo ancho que la 
base de madera, y rebasarla en el sentido vertical tanto arriba como abajo; rellenarla 
del color 442 C. Aplicar el estilo de capa Bevel and Emboss/Chisel Hard y nombrarla 
como “Base plata”.
19. Crear una nueva capa sobre ésta cargando su selección, y rellenarla del pantone 
432 C. Aplicar el filtro Add Noise a 270%, Gaussian y Monochromatic.
20. Aplicar el filtro Blur/Motion Blur a 28° y 57 pixeles; aplicar el modo de fusión de 
capa Overlay al 60%. Nombrar la capa como “Metal”.
21. Crear una capa de texto con la palabra “Fender”, en Century Gothic Bold de 20 pts. 
rellena de color 431 C; aplicarle el estilo de capa Inner Shadow.
22. Crear nuevas capas de texto por separado con las siguientes palabras: Gibson, Yamaha 
y La Patrie; y repartirlas sobre la barra de menús de forma equidistante y centradas por 
medio de las herramientas de alineación/distribución del menú de opcines de herramienta.
23. Copiar el estilo de capa de Fender y pegarlo en las demás capas de las otras marcas 
de guitarras.
24. Crear una selección rectangular que simule nuevamente la ranura entre menús, y 
rellenarlo del pantone 432 C. Copiar y pegar esta “ranura” entre cada texto.
25. Fundir todas las ranuras en una capa que nombraremos como “Ranuras metal”, y 
aplicarle el modo de fusión de capa Overlay al 70%.
26. Guardar del archivo en formato PSD en capas.

El practicante deberá obtener los siguientes resultados:
* Muestra en la siguiente página.
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Práctica 25
Estilos Web

Duración: 90 minutos

Objetivo: El practicante utilizará los estilos de capa y la paleta de estilos para generar 
estilos web.

Temas a Practicar: Estilos de Capa / Paleta de Estilos / Optimización Web

Desarrollo:
1. Generar un nuevo documento de 800 x 200 px, a 72 ppi
2. Guardarlo como Práctica 25
3. Generar una nueva capa y nombrarla como “Header 1”
4. Seleccionar un color azul #003366 de la paleta de colores web y con la herramienta 
de rectángulo con esquinas redondeadas, seleccionar en el panel de opciones, el modo 
Fill Pixels; en el submenú de opciones la opción Fixed Size a 760 x 140 px, y un radio 
de 10 px para las esquinas. Trazamos el rectángulo.
5. Crear una nueva capa y nombrarla como “Header 2”. Cargar la selección de la capa 
Header 1, usando la tecla Ctrl/Cmd, y desplazar la selección hacia arriba 10 px.
6. Seleccionar el color azul #6699FF de primer plano y color blanco de fondo, y relle-
nar con nubes desde el menú Filter > Render > Clouds.
7. Estando en la capa Header 2, restar la selección de la capa Header 1, presionando 
Ctrl/Cmd+Alt y dando click en Header 1. Borrar la parte que queda dentro de la selección 
activa. Soltar la selección.
8. Hacer una nueva capa y nombrarla como “Luz”. En esta capa cargar la selección de 
la capa Header 2, y desde el menú Select > Modify > Contract, contraer la selección 2 px. 
9. Con la herramienta de degradados, usando la opción Multiply del panel de opciones, 
trazar un degradado lineal de blanco a transparente del borde hacia dentro (20 px) de 
cada uno de los cuatro lados de la selección. Soltar la selección.
10. Escribir el título “MUNDO MAYA”, con la tipografía Times Regular de 35 pts, color 
azul #003366.
11. Abrir la foto “Ruinas”, seleccionarla y copiarla. Regresar a la práctica, ubicarnos en 
la capa luz, cargar la selección de la capa Header 2, y pegar desde el menú Edit > Paste 
Special > Paste Into. Nombrar esta capa como “Ruinas”.
12. Repetir el paso anterior para las fotos “Pareja” y “Chichen Itza”. Nombrar las capas 
con el nombre correspondiente a cada foto.
13. Encimar cada una de las fotos unos 20 px.
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14. Nos ubicamos en las máscaras de capa de cada foto. Con color negro de primer 
plano y blanco de fondo, la herramienta de degradados y la opción Multiply en el panel 
de opciones, aplico un degradado lineal en la parte en donde se enciman las fotos para 
desvanecer las uniones.
15. Seleccionar todas las capas generadas y meterlas en un grupo llamado “Header”.
16. Con la herramienta de rectángulo con esquinas redondeadas, usando la opción 
Fixed Size y un radio de 5 px para las esquinas, hacemos una pleca de 680 x 25 px con 
el color #6699ff, para los botones y le aplicamos algún estilo con los efectos de capa. 
17. Guardar nuestro estilo en el panel de estilos y explorar los estilos para web de la 
librería Web Styles.
18. Con la herramienta de texto, tipografía Arial 12 pts, color azul #000033, escribir los 
siguientes textos para los botones cada uno en una capa independiente: Introducción, 
Sitios Arqueológicos, Hospedaje, Restaurantes y Tours.
19. Seleccionar todas las capas de texto y la pleca de botones, alinearlas al centro hori-
zontal. Ubicar el texto del primero y último botón, y distribuirlos al centro horizontal.
20. Generar en nuevas capas las ranuras entre cada botón. Alinear estas capas en sentido 
horizontal y combinarlas; aplicarles el modo de fusión de capa Overlay.
21. Seleccionar todos las capas correspondientes a los botones y meterlas en un grupo 
nombrándolos como Botones.
22. Con la herramienta de Slices, hacer los sectores correspondientes al header y a cada 
botón.
23. Guardar como PSD y Save for Web, dando la optimización adecuada a cada slice.

El practicante deberá obtener los siguientes resultados:
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Práctica 26
Soportes 3D

Duración: 70 minutos

Objetivo: El practicante conocerá y utilizará los soportes 3D incluidos en el programa.

Temas a Prácticar: Perspectiva (Vanishing Point) / Soportes 3D

Desarrollo:
1. Abrir el documento Galería arte.
2. Desde el menú Filter > Vanshing Point, trazar con la herramienta de creación de planos, 
los planos correspondientes a cada uno de los muros y al piso, usando la tecla Ctrl/Cmd 
para hacer planos conectados entre si. Dar OK para salir del filtro.
3. Guardar el documento como P_26, para que queden guardados los planos creados.
4. Crear una nueva capa y volver a entrar al filtro Vanishing Point. Desde ahí seleccio-
namos la herramienta Stamp, y ajustamos las opciones Diameter: 80%, Hardness: 50%, 
Opacity: 100%, Heal: On, Aligned. Clonar parte del zoclo para tapar los tres contactos 
en los muros y uno en el piso.
5. Abrir las fotos ubicadas dentro del fólder “Manuel Álvarez Bravo”.
6. Reducir las fotos a un promedio de 4 cm de ancho por lo que den de alto. Las que 
irán en primer plano un poco más grandes, las que van al fondo de la galería más 
pequeñas.
7. Ir seleccionando las fotos al gusto, copiar, regresar a la práctica, generar una nueva 
capa para cada foto, entrar al filtro Vanishing Point y pegar. Arrastrar la foto sobre alguno 
de los lienzos azules y ajustar el tamaño al mismo con la herramienta Transform, procu-
rando dejar las fotos rebasadas en todos sus lados.
8. Repetir el proceso hasta tener una foto en cada capa y en cada uno de los cinco lienzos 
azules. Nombar las capas como: Foto 1, Foto 2, Foto 3, Foto 4 y Foto 5.
9. Para recortar las fotos exactamente al tamaño de los lienzos, ocultamos las capas de 
las fotos, cargamos la selección de los lienzos por medio del comando Color Range 
desde el menú Select y seleccionamos el color azul con Fuzziness: 200. 
10. Una vez cargada la selección, hacemos visible cada una de las capas de las fotos y 
le añadimos una máscara de capa para recortar el excedente. Podemos volver a cargar 
la selección desde la máscara de capa usando la tecla Ctrl/Cmd para recortar cada foto 
por medio de una máscara de capa nueva.
11.Generar una nueva capa para matizar las fotos, nombrarla como “Sombras”.
12. Cargar la selección desde cualquier máscara de capa de las capas de foto. Seleccionar la 
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herramienta Gradient con color negro de primer plano, en el menu de opciones seleccionar 
un gradiente de negro a transparente, linear, opacidad 25% y aplicarlo de abajo para 
arriba cubriendo la selección.
13. Con la herramienta de texto escribir “Manuel Álvarez Bravo 1900-2000”; seleccionar 
fuente y puntaje al gusto, rasterizar la capa de texto, seleccionar todo, cortar, entrar al 
filtro Vanishing Point y pegar, ubicando el texto en el muro principal, ajustar tamaño y 
opacidad al 50%.
14. Finalmente desde el filtro Vanishing Pont seleccionar la opción >Return 3D Layer to 
Photoshop  y explorar las opciones de la ventana de edición 3D.
15. Guardar el archivo en formato PSD.

El practicante deberá obtener los siguientes resultados:




